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SECTION 1
1 Defense Message System (DMS Version 3.0)

Section Objectives

After completing this section, you will be able to:

· Describe the local message storage and archiving policy

· State signature and encryption requirements

· State how to verify the DMS software version

· Describe current DMS goals

· Identify helpful Web sites relating to DMS

· Explain the DMS Architecture

1.1 General Information

1.1.1 NTP 21(A)

a. Naval Computer and Telecommunications Command developed the Naval Telecommunications Procedures (NTP) 21(A) Defense Message System (DMS) User's Manual. NTP 21(A) outlines procedures and instructions for the preparation and electronic delivery of DMS organizational messages. All users of the DMS system should become familiar with its contents.

1.1.2 Local Message Storage and Archiving 

a. The DMS does not retain and archive transmitted messages.  Message archiving and retransmission are organizational user responsibilities.  All organizational users are responsible for locally storing complete copies of both outgoing and incoming messages on-line for a minimum of thirty (30) days after submission and receipt.  After thirty (30) days, stored messages must be archived in accordance with the organization's local policies.  During this 30-day period, both outgoing and incoming messages shall be stored with the original security services invoked.  This requirement supports message trace actions and retransmission requests (NTP 21(A) Section 807).

1.2 Microsoft Outlook 2000

a. Microsoft Outlook is the User Agent used in DMS. Although DMS messages look like email, they are Organizational Messages, governed by all the rules of U.S. Navy messaging. 

b. All DMS messages transmitted on the DMS system will be Signed and Encrypted. The default for Microsoft Outlook UA is set to Digitally sign messages and Encrypt message contents and attachments. This is U.S. Navy Policy and may not be waived.

c. All messages transmitted from DMS Microsoft Outlook are organizational messages (official Navy messages), and as such, must be released by an authorized releasing officer. This includes ‘Reply To,’ ‘Reply To All,’ and ‘Forward’ messages.

d. The DMS version can be seen by clicking on Start, Run. Type dmsver in the Open window and click OK. The current version of DMS will be displayed.

1.3 What Is Going On In DMS

a. Ashore (DMS Functional) – DMS 3.0 with V3 Certificate FORTEZZA, concurrent ops to support DMS Transitional Hub (DTH) closure on September 30, 2003.

b. Ashore (DMS Non-Functional) – Support DTH closure on September 30, 2003 by implementing the Tactical Messaging Gateway (TMG) for ashore users until they cutover to NMCI using the DMS capability.

c. Afloat – Support DTH closure on September 30, 2003 by implementing the TMG as an interim step.

1.4 DMS Reference Documents 

1.4.1 Located on DMS 3.0 Client CD

a. ACP 120 Quick Reference Guide (QRG) (acp120qrg.doc)

b. Non-Delivery Notice (NDN) Trouble Shooting Guide (ndn_summ.doc)

c. User Documentation for PAB/Contacts X.500 Synchronization Tool (pabsync.doc)

d. Message Processing Error Reference Guide for DMS Products (msg_errors.doc)

1.4.2 Located on the 3.0.2-MSCLIENT-D02 FEN

a. DMS Client Reference Guide (crg.doc)

1.5 DMS FORTEZZA Certificates

a. DMS Version 3.0 uses V3 certificates effective April 1, 2003. V3 certificates support Common Security Protocol (ACP 120). The older V1 certificates are no longer authorized for use unless a catastrophic failure of V3 certificate occur, in which case, a General message will be transmitted to all commands providing guidance.

b. Guidance for using V3 certificates are contained in the following documents/messages.

1. DMS Global Systems Manager (GSM) Advisory Notice to Activate V3 Accounts 

2. MARADMIN 146/03 DTG 281845Z MAR 03, From CMC Washington DC

3. ALCOM 021/03 DTG 282315Z MAR 03, From NAVNETSPAOPSCOM DET Washington DC

4. ALCOM 023/03 DTG 312045Z MAR 03, From NAVNETSPAOPSCOM DET Washington DC

c. To obtain new V3 certification, each command must submit a X.509 form to the DSP responsible for creating FORTEZZA cards.

1.6 DMS V3 Messaging

a. DMS V3 messaging, made possible by Release 3.0 Gold, implemented significant security enhancements for the DMS user.  It provides the ability to control the origination and receipt of organizational messages containing Special Category/Special Handling Designators (SPECAT/SHD) security caveats on an individual user basis.  With v3 messaging, DMS users can now exchange SPECAT/SHD messages and messages with other caveats, where authorized, paving the way for AUTODIN closure.

1.7 DMS WEB Sites

	https://www.dmshelp.navy.mil (DMS Global Help Desk)
	https://dms.navy.mil (Download MasterKeyPlus and DBU-2)

	
	

	http://www.icecomm.com (TurboPrep Download Site)
	http://www.dmds.navy.mil (DMDS Download Site)

	
	

	http://disa.dtic.mil/apps/apm (DISA DMS Site)
	https://dms.navy.mil/legacy (SPAWAR Legacy Site)

	
	

	https://c4iweb.spawar.navy.mil.pmw166/ec_readiness
	http://www.nctamslant.navy.smil.mil (NCTL Web Site and DPVS Download site.


1.8 DMS Architecture

a. A simplified drawing of the DMS architecture is shown on the next page.
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SECTION 2

2 Accessing a DMS Mailbox

Section Objectives

After completing this section, you will be able to:

· Describe the steps to access a DMS mailbox

· Describe the types of DMS connectivity

a. In order to access a DMS mailbox, a command must have a DMS Enabling Capability (EC). The EC is a computer with DMS User Agent (UA) software installed. The UA software is Microsoft Outlook 2000 with additional military properties. The EC also has a PCMCIA slot for a FORTEZZA card and a connection method to the Local Command Center (LCC)/DMS Service Provider (DSP), where the mailbox is located. (We will refer to the Communications Center serving your command as the DSP.)

b. The connection method for Sensitive But Unclassified (SBU) can be dial-in via modem, a NIPRNET connection, or connecting a Group Ware Server (GWS) to the DSP via NIPRNET.

c. The connection method for Secret (which includes Confidential) can be dial-in via STU-III or Sectera Wireless Terminal; a SIPRNET connection, or connecting a GWS to the DSP via SIPRNET.

2.1 Dial-in Connection

a. A dial-in connection for SBU is accomplished via a 56 K modem.

b. Using Microsoft Dial-Up Networking, telephone numbers for the DSP Remote Access Server (RAS) are programmed into the software. 

Note: It is extremely important to the operation of the DMS system that the EC clock is set accurately. 

c. Clicking the Dial-up Networking icon will start the process. A Connect To window is then displayed; enter User name, Password, and Logon domain name, and click the Dial button. The process is displayed through a series of notices until the connection is made with the DSP RAS.
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SECTION 3

3 Microsoft Outlook 2000

Section Objectives

After completing this section, you will be able to:

· Describe how to start the DMS User Agent Microsoft Outlook 2000

· Identify the DMS Inbox components and icons

· Describe required settings for DMS Outlook

· Describe how to display DTG in Inbox Viewer

3.1 Setting Up V3 Mailbox

a. After April 1, 2003 all DMS users must use the FORTEZZA V3 certificate. A separate V3 mailbox for every command has been created at the DSP for this purpose.

b. As a general rule, a System Administrator (SYSADMIN) is required to accomplish this task.

c. Right click on the Microsoft Outlook Icon.
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d. When the “DMS Profile Properties” window is displayed, click on Show Profiles button. A “Mail” window will be displayed. Highlight the DMS Profile and click on the Properties button. A “DMS Profile Properties” window will be displayed for that profile, highlight “Microsoft Exchange Server” and click on the Properties button.
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e. The “Microsoft Exchange Server” window will be displayed. Re-type the Mailbox name and click on the Check Names button. You will be prompted for the User Name/Password of the mailbox. Add the required information in the “Enter Password” window and click OK. A “Check Name” window will be shown. In the “Change to” window, highlight the V3 mailbox and click OK.
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f. When the mailbox displays the V3 mailbox name in the “Microsoft Exchange Server” window, click OK. At the next window click OK and then Close.
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3.2 Starting Outlook

a. Start Microsoft Outlook by double-clicking the Microsoft Outlook 2000 icon. The Choose Profile screen will be displayed. Select the applicable MS Exchange profile and click OK. An Enter Password screen will be displayed. Ensure the User Name and Domain Name are correct, then type in the Password. Click OK.  The Defense Message System Version screen will be displayed. Note the DMS version is displayed at the top of the screen.  Click the Agree button.
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3.3 Viewing Outlook

a. The Inbox - Microsoft Outlook window will be displayed. On the left is the Folder List and on the right is the Preview Pane. 
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b. The Inbox – Microsoft Outlook Preview Pane will display a listing of all messages contained in the inbox.  The list shows information for each message in a table that has seven columns: Importance, Icon, Flag Status, Attachment, DTG, From, Subject, and Received (date and time).
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Importance Symbols

· Icon Symbols
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Message has an attachment

c. The DMS Outlook window toolbar is the same as non-DMS Outlook with the exception of the icons on the right (DUA Browser, FORTEZZA Security Logon and FORTEZZA Security Logoff).
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3.4 Required Settings for DMS Outlook

3.4.1 DMS User Mailbox

a. DMS requires that the user mailbox is server-based. To check/set this requirement, click on the Tools drop-down menu, and then click Services. When the Services window is displayed, click the Delivery tab. In the Deliver new mail to the following location: box, make sure the Mailbox – (Mailbox Name) is displayed. Change using the drop-down arrow to the right of the box. When complete, click OK.
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3.4.2 Reset Toolbar Settings

a. Instructions to reset Tool Bar Settings are contained in the installation instructions for DMS 3.0, Section 7.7.

3.4.3 Disable AutoSave Functionality

a. Instructions to disable AutoSave functionality are contained in the installation instructions for DMS 3.0, Section 7.8.

3.4.4 Configure High Precedence Alert

a. Instructions for configuring a High Precedence Alert are contained in the installation instructions for DMS 3.0, Section 7.9.

3.5 Optional DMS Settings

3.5.1 Populate the From Field from the Currently Selected FORTEZZA Role

a. The “From” window can be displayed with the currently selected FORTEZZA role by selecting a default setting in the Outlook screen drop down menu.

b. Minimize the Outgoing message template. This will allow access to the Outlook screen. Click on the Tools drop down menu, then click on Options.
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c. Click on the DMS tab. Place a check to the left of Populate “FROM field with currently selected Fortezza Role”. Click OK. Maximize the New Message Template.
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d. Whatever FORTEZZA role is selected, it will be displayed in the From window.
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3.6 Date Time Group (DTG)

a. The DTG identifies the Date and Time when a message was released. Because of this, it may be useful to see the DTG in an inbox view.

3.6.1 Define the DTG as a User Defined Field

a. From Outlook Drop down Toolbar, click on Tools, DTG Extraction.
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b. From the DTG Extraction Tool menu, click on the Select button. From the “Select mailbox or folder” click on the plus sign to the left of Mailbox and click on the Inbox. Click on the Insert DTG button. This will add the DTG as a user defined field in the Inbox view. Click OK and then Exit.
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Display the DTG in the Mailbox Inbox

a. From Outlook Drop down Toolbar, click on View, Current View, Customize Current View and the click on the Fields button.
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b. From the “View Summary” window click on the Fields button. At the “Show Fields” window, click on the drop down arrow and highlight “User-defined fields in inbox”. Click on the DTG field and click on the Add button.
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c. The DTG field will be added to the “Show these fields in this order:” window. Move the DTG field up or down using the appropriate buttons. Click OK.
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d. At the “View Summary” window, click OK. The DTG column is now placed in the Mailbox Inbox view pane.
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3.6.2 Extracting the DTG from Unread Messages

a. Click on the Tools drop down Toolbar and then DTG Extraction.
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b. Click on the Select button on the “DTG Extraction” menu. On the “Select mailbox or folder” menu, click on the plus sign the left of the Mailbox and click on the “Inbox” folder. Click on OK, then click on the Start button to extract the DTG from the unread messages. A progress meter is displayed.
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c. Click on Exit to exit the tool. The Date Time Groups have been extracted from the messages, which remain unopened.
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SECTION 4

4 DMS Message Addressing

Section Objectives

After completing this section, you will be able to:

· Describe basic DMS addressing terms

· Describe how to obtain DMS addresses through MasterKeyPlus

· Explain how to add a DMS address to the Microsoft Outlook Public Address Book

· Explain the MasterKeyPlus Standalone Browser Search function

· Describe how to obtain a DMS address from incoming messages

· Describe how to add office codes to PLA addresses

· Describe how to use the PAB Synchronization Tool

4.1 Addressing DMS Messages

a. In Accordance With ALCOM 021/03, effective 010001Z APR 2003, all outgoing DMS messages shall be signed and encrypted using V3 FORTEZZA certificates and shall be addressed to DMS V3 organizational addresses. If an intended recipient does not yet have a working V3 DMS directory entry, identified by a UC, SC or TC suffix, the outgoing V3 message must be addressed using the recipients organizational Plain Language Address (PLA) entry in the AUTODIN PLA portion of the DMS directory.
b. Navy DMS organizations are located under the Organizations(XX) branch of the Navy directory tree, where the XX suffixes of UC, SC, TC correspond to Unclas, Secret and Top Secret enclaves respectively. Current Non-DMS users are not affected by the V1-V3 transition.
c. DMS-to-DMS V1 messages are not authorized therefore, Navy organizations currently using DMS V1 certificates who are not yet V3 capable must revert to their legacy Gateguard terminals on 1 April 2003 until they become V3 capable.
d. No DMS message can contain more than 150 total entries in the To:, CC:, and BCC: fields. This includes the combination of DMS, SMTP, AUTODIN, and Address List addressees. (This does not apply to the size of the mail list, which is considered to be a single entry.)

4.2 Address Lists

a. Address Lists are the V3 equivalent of Mail Lists which are the V1 equivalent of AIG/CAD. Address Lists support V3 messaging exclusively.

4.3 Distinguished Name (DN) Naming Convention

a. The Distinguished Name (DN) is dependent on the type of certificate the user has been issued. 

b. A Security Domain Identifier follows each DN. The identifier is contained within parentheses.

	Identifier
	Classification
	Certificate
	
	Identifier
	Classification
	Certificate

	(n)
	SBU
	V1
	
	(uc)
	SBU
	V3

	(s)
	Secret and below
	V1
	
	(mc)
	SBU and 

Secret and below
	V3

V3

	(t)
	Top Secret
	V1
	
	(sc)
	Secret and below
	V3

	
	
	
	
	(tc)
	Top Secret
	V3


· Example: COMSPAWARSYSCOM SAN DIEGO CA(uc) is DN for V3, SBU.

4.4 The DMS Directory

a. The DMS uses an X.500 directory as a single repository for the most current addresses for all DMS users.

b. The DMS directory is located at the DSP. In order to obtain addresses for DMS outgoing messages, the user must be connected/logged in to the DSP.

c. Several methods are available for obtaining DMS addresses. One is the same DUA Browser used in previous versions of DMS, and the other is MasterKeyPlus (MK+), a new method of obtaining addresses from the DMS Directory.

d. Both programs are automatically installed when DMS 3.0 is installed on the DMS EC.

e. The Preferred Delivery attribute in the Directory cannot be displayed using the DUA browser. MasterKeyPlus must be used to view the Preferred Delivery attribute. The attribute is a text field is this form (0a01XX). If XX is 00, it indicated SMTP address, 01 indicates AUTODIN address, and 02 is for DMS address.

f. If you are going to use Contacts instead of the PAB on your EC, MK+ is required since the DUA Browser cannot be used to populate Contacts. In all cases MK+ is the recommended browser.

4.5 Using MasterKeyPlus

a. MasterKeyPlus (MK+) contains many new features over the DUA Browser in previous versions of DMS.

b. When attempting to locate an entry in the DMS directory using MK+, it is recommended that the search function be used instead of browsing (drilling down) the directory. X.500 directories are designed to provide very fast responses to searches.

c. Using MK+ eliminates the need to store DN DMS addresses in the PAB or Contacts folder. It is recommended that entries stored in the PAB or Contacts be limited to AUTODIN PLAs with office codes appended.

4.5.1 MasterKeyPlus Search Function

a. Click the New Mail Message icon in Microsoft Outlook.
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b. Enter an address in the To window. Click on the “Check Names” icon
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c. A check names window will be displayed. In this case there are 3 addresses for COMSPAWARSYSCOM. The bottom address is a AUTODIN PLA address as indicated by the lack of an identifier. The middle address is a V1 certificate address as indicated by the (n) identifier.  The top address is a V3 certificate address as indicated by the (uc) identifier. Highlight the V3 certificate address and click OK.

Note: In this course of instruction we will not send any messages to any command. We will send messages between students.
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d. This will place the V3 certificate address in the To or action addressee window. Continue to select action addressees in the same manner. 
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e. Information (Cc) addresses can be selected in the same way. Type USS Thorn in the Cc window and click on the Check Name icon. USS THORN will be underlined indicating it is a good address obtained either from the DSA or PAB.
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f. Address properties can be viewed by right clicking on the address and click on Properties. AUTODIN PLA addresses will be indicated by O=DTH as part of the address. DN addresses will not have a DTH (DMS Transition Hub) entry. Note the address can be added to the PAB from the properties screen also. Click OK to close the window.
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4.5.2 MasterKeyPlus Standalone Browser Search

a. Click the MasterKeyPlus Browser icon in either the New Mail Message template or in the Inbox-Microsoft Outlook window to display the directory browser.
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b. The MasterKeyPlus Browser will be displayed. Click the Find icon (Binoculars). This will display the Browser Search window. Using the Simple Finder tab, enter COMSPAWARSYSCOM in the window to the right of Name. Click OK. The program will search for the address.
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c.  When the program locates the address, it is displayed in the right window.   Right click on the address to open a drop down window. From this window you can add the address as an action (To), information (Cc) or a Blind copy (Bcc). You can also add the address to the PAB by clicking on the “Add to” menu and click on “Personal Address Book”. To close the browser, click on the drop-down menu “File” and “Close”
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4.5.3 MasterKeyPlus Standalone Browser Drill-Down

a. To browse the directory for an address, click the MasterKeyPlus Browser icon.
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b. To open a level, click the plus sign to the left of the icon.
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c. Continue to open levels through the service branch (Navy), Organizations(uc), Location (State/Country), Location (City/Base), until you find the addressee.
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d. When you reach the command name, highlight it and click the Add to icon to add the address to the PAB. To close the browser, click on the drop-down “File” and “Close”.
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d. To close the DMS New Mail Message template, click on “File” and “Close”. When asked to save the message click “No”.
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4.6 Obtaining an Address from an Incoming Message

a. Open any incoming message and highlight the address you wish to place in your PAB. Right click on the address and then click on  “Add to address book”. This will place that address in your PAB.

4.7 Office Codes for PLA Addresses

a. Office codes can be added to PLA addresses only. To add an office code to a PLA address, click the DMS Office Code Editor icon. The DMS Office Code Editor – X.400 Addresses window will be displayed. Select a PLA address from the list and click Modify.
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b. In the Office Code window, type the office codes starting with four forward slashes and ending with four forward slashes. Separate each office code with two forward slashes. When finished, click OK. When the DMS Office Code Editor window is displayed, select another PLA address and add the office codes. When finished, click Close.
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4.8 PAB Synchronization Tool

a. The PAB - X.500 Synchronization Tool provides the ability to automate the PAB update. The tool will read each PAB entry and determine the nature of the entry.  If it’s an X.400 address, the tool will use the X.500 DN to read the entry from the X.500 directory at the DSP and update the address and certificate.  

b. To synchronize your PAB, click Tools, Synchronize, and Address Book.
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c. The X.500 PAB/Contacts Synchronize window is then displayed. Select Personal Address Book or Contacts Folders. This will depend on whether you are using the PAB or Contacts to store your DMS message addresses. Click Start.
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d. The PAB Sync Tool will examine each address in the PAB or Contacts and match it with the address in the directory. When the tool has completed synchronization, a summary status is displayed showing the number of PAB entries synchronized, the number not synchronized, and the number of skipped entries. This summary can be saved to disk file by clicking the Save Screen Status button in the top left corner of the screen, selecting the folder to save the file in and naming the file. Click on the Close button.
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SECTION 5

5 DMS MESSAGING

Section Objectives

After completing this section, you will be able to:

· Describe how to apply addressing and military properties to a DMS outgoing message

· Identify the components to be completed in an outgoing message

· Define the guidelines for sending file attachments

· Explain how to add office codes to a DMS outgoing message

· Describe how to read a DMS message

5.1 Elements of Service

a. The ACP 120 U.S. Supplement requires that each organizational DMS military message must contain an originator indicator, primary and copy recipient’s indication, subject indication, primary precedence, message type, and extended authorization. The following table indicates the location where each attribute can be entered on message origination, as well as the location the information can be found on received messages. Check your service or agency’s specific policies for further guidance.

	Elements of Service (EOS)
	Location in New Message
	Location in Incoming Message

	Originator Indication (From Line)
	Message Tab
	Message Tab

	Primary & Copy Recipients
	Message Tab
	Message Tab

	Subject Indication
	Message Tab
	Message Tab

	Primary & Copy Precedence
	Message Tab
	Message Tab

	Message Type
	Message Tab
	Message Tab

	Extended Authorizations (DTG)
	Military Tab
	Military Tab

	Note: Extended Authorization along with the Originator provides a common message reference. It is used by the Multi-Function Interpreter (MFI) to generate the DTG in an AUTODIN message.

	

	ACP 123 U.S. Supplement does not require the use of message instructions, handling instructions, originator reference, and distribution codes.

	Message Instructions
	AUTODIN Tab
	AUTODIN Tab

	Handling Instructions
	AUTODIN Tab
	AUTODIN Tab

	Originator Reference
	AUTODIN Tab
	Advanced Tab

	Subject Indicator Code
	AUTODIN Tab
	Advanced Tab


5.2 Outgoing Messages

5.2.1 Preparing an Outgoing Message

a. Ideally, messages requiring USMTF format, such as GENADMIN, will be drafted in TurboPrep, which has been linked to MS Outlook during setup. It is recommended that the user draft messages while offline, and have them released and ready to be sent when the user logs on to the DSP.

b. To open an outgoing message template, click the New icon in the Outlook window.

[image: image93.png]i¥% DMS TEST MESSAGE - Message (HTML) - US-ASCIL

=18 x|
[Ele Edt v Iert Fomat Tods actons te

|=send B & 5 @R 0B | AR & @ron |[Eiom S e | Convert | @eac

wassaoe | iy | mecpens | advorced | surooms | ot |

Delivery Options

B P s opion .
T Prohbt ceivery to Dead Letter Malborc

I~ Noleter than: [o9/17/2002 - 0e41:25 =
I prohibit delivery to a specfied lternate recipient

Expie ths Message

@  ever
Cm [ intes =]
Con [osjizpaone-o9atzs o]

Content Conversion

% & Allow applcable conversions o this message

0 ot allow conversions on this message.

00 not allow conversions on this message in case of nformation oss





c. The Untitled – Message window will be opened.
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5.2.2 From Field

a. Using the From field is necessary only if the user has a profile with two or more mailboxes. Your primary mailbox is indicated by the words Outlook Today next to the mailbox in the folder list.

b. All messages are sent from the primary mailbox (Default). The “From” field will need to be selected only if you are sending a new message, replying, or forwarding from a secondary mailbox.

c. To display the From window after a New Mail Message Template is displayed, click the From icon. The From button and window will be displayed. 
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d. Click on the From button and select the address from the ‘”Choose Sender” window you wish to send the message from, then click OK. The address will be displayed in the From field..
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Copy the Outgoing Message into the Message Body

a. The next step is to copy the released, outgoing message text into the body of the message template by any method you desire. The message file can be opened in TurboPrep and mailed to the Outlook template. You can use a cut and paste operation from Notepad or similar text editor. For classroom purposes we will type TEXT in the text window.

[image: image97.png]DMS Security Label

(3 the ecurty Lol s been succesfuly saved o dk

==





Address Message

a. Address the message by typing the recipients address in the To and Cc windows as necessary, clicking on the “Check Names” icon after each entry.
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Assign a Subject

a. A subject is mandatory on all DMS messages.  If the subject was not automatically entered when the message was mailed from TurboPrep, type the message subject in the window to the right of Subject. The Subject field can be only 128 characters in length.
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5.2.3 Selecting Elements of Service

a. Start assigning the Elements of Service by clicking on the drop-down arrow to the right of Primary Precedence and selecting the appropriate action precedence. Follow the same procedure for the Copy or Info Precedence.
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b. Assign the message type by clicking on the drop-down arrow to the right of the Type window.  “Other-Organizational” will ALWAYS be used with all messages drafted by Navy commands until notified otherwise. If you use a type such as Exercise, you may type additional information pertinent to the exercise in the Type ID field.
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· Note: CLASS ROOM ONLY. Select “Individual (Working Record)”. Without the FORTEZZA card, we can not send messages using “Other – Organizational”.

5.2.4 Assign the Date Time Group (DTG)

a. Click the Military tab. Place a check in the check-box to the left of Release Date/Time (Zulu). This will apply the GMT DTG. If you want a different DTG, click on any of the digits comprising the time and change them. To change the day, click on the drop-down arrow to the right of the time and a calendar will be displayed.  The window to the right of Content Description can be used to describe the contents of the message. If nothing is entered in the field, the message subject will be automatically copied into this field. This field is in the clear and will be displayed in the Inbox viewer as the subject PRIOR to decrypting/opening the message. After the message has been decrypted/opened, the internal subject will be shown in the viewer.
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5.2.5 Receipts and Delivery Notices

a. Delivery reports are system notifications sent when a message has been delivered to the recipient mailbox. A Read Receipt is a system notification sent when an addressee opens the message. Signed or signed/encrypted messages produce signed read receipts.

b. Click the Recipients tab. The message’s addressees are listed in the right side under Type and Recipient. Click the drop-down arrow to the right of Delivery Report and choose All Recipients if you want to receive a delivery report from the addressees. Use the same procedure for Read Receipt and Reply Requested.
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5.2.6 Advanced, AUTODIN, and Other Tabs

a. These tabs are available to users if additional information is required to be conveyed to addressees. 

Advanced Tab
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AUTODIN Tab

b. Fill in appropriate information as applicable.
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Other Tab

c. Exempt is used to exempt recipients from Address Lists. Authorized by is used to place the address of the command authorizing the exemption. Other Recipients is used to place the name/address of any other recipients of the message. E.G. a commercial company that was provided a copy of the message.
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Note: After completing all tabs, return to the “Message” tab.

5.3 Sending a DMS Message

a. After all the properties have been added to the message, send the message by clicking the Send icon.  If the FORTEZZA role has expired, the “Fortezza Security Logon” window may be displayed, re-enter the FORTEZZA Pin and Click OK, select the proper V3 role and click OK.
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b. The Security Label window will be displayed. Although it is not required to set a security label tag for unclassified messages, the procedure is shown to demonstrate the steps.

c. When the “Security Label” window displayed, click on the “GENSER Categories” option in the “Tag Sets” window and click on the “Add>>” button or double click on the “GENSER Categories”.
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d. The “GENSER Categories” will move to the “Selected Tag Sets” window. Highlight and click on the Edit button or double click on the “GENSER Categories”.
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e. The “GENSER Categories window will be displayed. In the left window, select SBU and click on the “Add->” button or double click on  “SBU”. This will move the SBU to the right screen. Click OK.
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f. To save the settings, place the curser in the “Security Labels:” window and type a name for the label such as “SBU Label” then click on the Save button to the right of the window. Click OK when the “DMS Security Label” window is displayed. Click OK to complete the Security Label.
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g. The “Security Label Details” window will be displayed. Click OK. The recipients will be validated and the message will be processed and transmitted.
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5.4 Attachments

a. File attachments such as word-processing documents, graphics, and rich text file extensions are supported in the DMS.  

b. Binary file attachments (that is, word-processing documents, graphics, and rich text file extensions) may be transmitted between DMS users; however, binary file attachments shall not be included in messages that contain AUTODIN recipients.

c. The maximum size for messages transmitted between DMS-to-DMS users is 4.128 MB.  Up to 128 k of this maximum message size may be allocated to the message text.  The remaining 4 MB of the maximum message size are allocated to file attachments.  DMS allows multiple attachments as long as the total size of the message text and attachments does not exceed 4.128 MB. 

d. The maximum size for messages that include AUTODIN recipients is 1 MB. Messages that include AUTODIN recipients shall not contain Rich Text Format (RTF) instructions or include binary file attachments.

e. Messages that include AUTODIN recipients may include ASCII file attachments; jowever, the maximum size (message text and ASCII-based attachments) of messages destined to AUTODIN recipients shall not exceed 
1 MB. 

5.5 Readdressing a Message in DMS

a. Message originators and recipients may find it necessary to transmit a message for an activity that has a need-to-know, but who was not an addressee of the original message. This type of message is called a Readdressal. To start the process, open the message to be readdressed. (Double click on “DMS TEST MESSAGE”.
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b. When the message is displayed, click on the Forward tab.
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c. Add the addresses of the readdressal recipients by choosing them from the PAB or searching via MasterKeyPlus. Then click on the Military tab.
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d. Add a DTG. If receipts are desired, click on the Receipts tab and select the appropriate receipts from the Receipts window. Click on the Message tab.

[image: image116.png]/0 ¥ /g/oTe

From

7

[subject

[Received





e. Edit the Subject line to read “MSG READDRESSAL” and send the message.
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5.6 Office Codes for DMS Messaging

a. The Navy policy for office codes in DMS messaging is, “Office Codes shall not be used in the header of a DMS Organizational Message. If a DMS user requires the use of office codes, the user shall include the office code following the PASS TO OFFICE CODES: delimiter. To place office codes in a DMS message, bring the message into the MS Outlook New Message template. After addressing the message and attaching the Military Properties, add PASS TO OFFICE CODES: and list the commands/office codes desired.”
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5.7 Incoming Messages

a. In order to read a DMS message, the operator must decrypt each message using the FORTEZZA card. This can be accomplished manually or via DMDS.

5.7.1 Reading a DMS Message

a. Highlight and double click on the message you wish to read. A “Security Label Details” window will be displayed showing the security label of the message. This only occurs with V3 Certificate messages. Click OK.
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· Note: Since there are no student FORTEZZA cards, test messages are not signed or encrypted. 

b. The message will be displayed. Click on the Military tab to view the contents.
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c. The “Security Label” information is displayed.
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5.7.2 Read Receipts

a. Read receipts for signed and encrypted messages are signed. Double-click the receipt to open it.. If the FORTEZZA card is inactive, the Fortezza Security Logon window will be displayed. Type the PIN number for the FORTEZZA card and click OK. When the Select Roles window is displayed, select the proper role and click OK.
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b. The receipt is displayed. To close the message, click on “File” and “Close”.
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5.7.3 Delivery Reports

a. A Delivery Notice or Receipt is received when a command indicates a Delivery report and/or Read receipt in the outgoing message Military Properties. When received in the Inbox, it is from “System Administrator” and the subject is ‘Delivered:” followed by the subject of the outgoing message.

b. To read the delivered report, double-click on it. The message will be displayed. 
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c. To read the Undeliverable or Non-deliverable message, double click on it.
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SECTION 6
6 DMS BUSINESS UTILITY

6.1 Overview 

a. The DMS Business Utility 2 (DBU-2) product has been designed to provide a Commercial Outlook 2000 (O2K) client the ability to generate a message that a DMS 3.0 Client (User Agent) (UA) can open, modify, and send. 

b. DMS 3.0 allows the use of custom forms, which DMS 2.2 did not. Therefore, under the current scenario, when the DMS UA opens a message drafted by an O2K client, it will either be blank or missing required lines. This is due to O2K not being licensed to use specific files, which DMS 3.0 forms utilize. 

c. DBU-2 solves this issue by inserting the data from an O2K message into a DMS 3.0 form. 

d. The drafter will use a workstation with a minimum of 02K and MasterKeyPlus installed. MasterKeyPlus standalone can be downloaded from the website: https://dms.navy.mil 

e. DMS 3.0 EC will include an operational DMS 3.0 (3.0.2P.0) UA, TurboPrep and DMDS prior to the installation of the DBU-2 software.

f. Recommended system requirements: 

• CPU: Pentium II/III or compatible processor.

• Hard drive: 300 MB 

• RAM: 128MB 

g. Two shared/mapped folders are created on the Command LAN Server. One can be named “Draft” and the other, “Release”. 

h. If the command has connected the EC to their LAN, both folders must be accessible from the EC and the O2K computer. The Release folder should be designated the DBU-2 scan folder.

i. If the command does not have the EC connected to the LAN, released messages can be copied to a floppy disk and taken by hand (Sneaker Net) to the DMS EC and placed in a folder on the Hard drive.

j. The figure below represents a general configuration for DBU-2 with an EC connected to the Command LAN.
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k. The figure below represents a general configuration for DBU-2 with a EC NOT connected to the Command LAN
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6.2 Process

a. Several folders must be created on the command LAN Server. One folder (Draft) is used to hold outgoing messages while the Drafting Officer and others review them in the Command Chop chain. Once the Releasing Authority has authorized the message to be transmitted, it is placed in the other folder (Release), which is searched by DBU-2 and brought into a DMS EC Mailbox “Draft” folder.

b. An outgoing message is prepared using TurboPrep or CMP on a Commercial O2K computer. This computer has MasterKeyPlus stand alone software installed and directed at the appropriate IP address for the Primary DSA. This computer must be connected to the command LAN and have access to the Internet.

c. In addition to the message text and addressees, the drafter must indicate the Elements of Service (EOS) that are not available in Commercial Outlook such as the message precedence, classification and code words as necessary. 

d. Using TurboPrep along with the Commercial Outlook can supply the Classification by NOT checking the box to the left of DMS 3.0 when the classification window is displayed. This will allow TurboPrep to transfer the classification to outlook. (The Releaser (DMS operator) must remove the classification line prior to sending the message).
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e. This information will be used by the Releaser to assign the EOS information to the message when it is converted into the DMS message form.

f. The message is transferred from TurboPrep to Outlook.

g. The Drafter inserts the subject and addresses the message using MasterKeyPlus with either V3 Distinguished Names (DN) or AUTODIN PLA’s retrieved from the Directory User Agent (DUA).

h. The message is saved as either an .oft or .msg file and placed in the file server “Draft” folder created on the Command LAN Server.

i. Command policy will dictate who must review the message.

j. The message is reviewed by the Releasing Authority and placed in the file server “Release” folder created on the Command LAN Server.

k. When the Releaser connects the EC to the DSP and activates Outlook, he/she also activates DBU-2.

l. DBU-2 scans the “Release” folder, moves the message to the DMS Outlook Mailbox “Draft” folder.

m. The Releaser opens the message in the “Draft” folder and converts it to DMS 3.0 Outgoing Message Template.

n. The Releaser completes the required military properties and transmits the message.

6.3 Log on to DMS Outlook
a. After logging on to the DMS DSP, Log into DMS Outlook by clicking on the Microsoft Outlook Icon. When the DMS window is displayed click on the Agree button.
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b. The DMS Outlook screen will be displayed.
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6.4 Open DBU-2

a. Double Click on the DBU-2 Icon to open the program
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6.5 Set-up DBU-2

6.5.1 Set Type Of Alert

a. When the DBU-2 window is displayed, click on the Options drop-down menu, highlight Alert and select the alert desired. Play Sound plays a selected .wav file sound when a message is placed in the Mailbox Draft folder.
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b. When Show “Draft Dialog” is selected a full screen window is displayed, indicating the number of messages placed in the Mailbox Draft folder.
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c. When Show “Tray Popup” is selected a popup window is displayed, indicating the number of messages placed in the Mailbox Draft folder.
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6.5.2 Set Source Folder

a. Click on the Options drop-down menu and highlight and click on Set Source Folder. Locate the Share “Release” folder and click OK.


b. The number to the left of “Folder” indicates how many folders are to be searched.


6.6 Using DBU-2

6.6.1 Message Preparation

a. After a message has been prepared in TurboPrep, forwarded to the Drafting Officer and then to the Releasing Officer, the released message will be provided to the DMS EC operator.

b. If the command does not have the EC connected to the command LAN, the message can be placed on a floppy disk and taken to the DMS EC and copied into the “Release” folder located on the EC.

c. If the command has connected the EC to the command LAN, the message can be placed into a share “Release” folder, which has been mapped to the EC.

6.6.2 Retrieving and Sending a Released Message

a. Open DMS Outlook and minimize.

b. Activate DBU-2 by clicking on the DBU-2 Icon.

c. Start the DBU-2 scans by clicking on the Start Scan button. The DBU-2 log will begin recording actions taken by DBU-2. The designated folder(s) will be scanned. If there is a message(s) in the folder, the log will record the file name, DBU-2 will create a back up file (.bak) and place the message(s) in the DMS Outlook mailbox  “Draft” folder. The alert selected will be displayed.


d. In DMS Outlook there will be a message(s) in the Drafts folder. Double click on a message.


e. When the message is opened, notice the template is the commercial O2K template. To convert to the DMS 3.0 Template, click on the Convert button.


f. This will convert the O2K message template to the DMS Outlook New Mail Message Template. The following Elements of Service are part of the converted message: 

· The TO: information. 

· The CC: information. 

· The Bcc: information. 

· The SUBJECT information. 

· The BODY 

· Any attachments. 


g. Attachments can be used to convey the Precedence, Classification and any Code Words the DMS EC operator will need to complete the message. The DMS operator can open the attachment, set the appropriate military properties and delete the attachment.


h. The Releaser must accomplish the following prior to sending the message:

· Select the Primary and Secondary Precedence.

· Select the Message Type (Other – Organizational).

· Select the DTG using the Military Tab.

· Select the receipts/delivery notices desired using the Recipients tab.

· Select any additional military properties required.

· Select Fortezza Role.

· Send the message

i. If the classification was included in the message, the Releaser must delete it from the text because DMS 3.0 inserts the classification during the sending process.


j. After the message is cleaned up and the EOS are selected, send the message.


Stop DBU-2 Scanning

a. To stop the DBU-2 scanning process, click on the Stop scan button. A DBU-2 window will be displayed asking if you wish to stop scanning. Click  Yes and the program will stop scanning the folder(s).


6.6.3 Archiving the DBU-2 Log

a. To Archive the DBU-2 log, click on the File drop-down menu and click on Archive Log. A DBU-2 window will be displayed showing the location of the archived file and name.


6.6.4 Clearing the DBU-2 Log

a. To clear the log, click on the File drop-down menu and click on Clear Log. This will clear the information shown on the log.


6.6.5 Closing DBU-2

a. To close the DBU-2 program, click on the File drop-down menu and Exit. A DBU-2 window will be displayed asking if you really want to exit the application. Click Yes.


SECTION 7

7 Message Trace Process

Section Objectives

After completing this section, you will be able to:

· Describe the purpose of a message trace

a. A message trace is used to determine the cause of a non-delivery of a DMS message.

b. Before a message is declared non-delivered, the originator must ensure that the message has exceeded the message delivery threshold, as shown below.

	Precedence
	Message Delivery Threshold

	CRITIC
	30 Minutes

	ECP
	30 Minutes

	FLASH
	30 Minutes

	IMMEDIATE
	4 Hours

	PRIORITY
	6 Hours

	ROUTINE
	12 Hours


c. The message process is shown below:
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